What will happen

Intro to GIS – background and system

Intro to geologic maps as GIS

Simple intro to start using the program and think about maps

Digitize a map and learn the programs

Layout map for presentation

Intro to GIS – background and system

Geospatial/georeferenced data

Everything has a location, point on a map

Hardware, software, data, and user = GIS

Geologic map of Paris – first GIS

Basemap

Spatially controlled data on map

GIS allows us to look at all sorts of data in spatial reference

Ground observations – point and area

Topography, DEM, land cover

Remotely sensed – photos, images

Potential field

Geology

General data divisions

Raster = image

Vector

Point

Line

Polygon

Other topology and relations

Software

ESRI – lots of stuff and students/pros will see again

ArcView vs. Arc/Info

3.2 vs. 8.3

Use older, easier for now

Licenses

Interface for geology is written

Need more GIS for 8.3 

Hardware

Wintel (emphasis) or Unix

Tablet to laptop to workstation

Intro to geologic maps as GIS

Most complex representation ever 

Data rich – topography and geology, raster and vector

Spatial relations – point in a rock, age

Symbology has deep meaning, but is ambiguous

Locations errors

Establish relatively standard representation

Symbols, colors, lines

Legend is critical

Use GIS to document the representation 

Each item has specific meaning

Meaning is understood

Metadata

Data about data – what it is

Attributes are important, but so are other things

What, where, how, who

Scale of use, projection (detail), references

Must be complete as possible for data to be useful

Describe methods of analytical work

Lots of things for GIS

Start using the program and think about maps

Use ArcView 3.2 on PC

Good interface

GeoEditor/Geoclassifier for Geology

EditTools for Topology

Menus and tools

Extensions

Project, View, Layout

Theme vs. View

Start with basic interface for getting around

Start to use interface and see what is possible with getting around in a GIS.

Exercise 1.  Part A. Displaying a background Map in Geographic Coordinates

Start the program ArcView on the PC.  Double click on the “Views” icon.  Resize both the ArcView window and the View1 window to cover most of the screen.    

Click on the button with cross on it, below the Edit choice on the menu bar.  This button inserts “Themes” into the “View”.  A theme is a set of points, lines, or polygons, or a grid or image. These themes can be registered to some particular geographic Coordinate system.  If they are, then multiple themes can be Overlaid and analyzed together.

In the Add Theme window, navigate to the directory c:\ArcDemo or c:\data\ArcDemo under “Data Source Types”; choose Image Data Source (a Feature Data Source is a point, line, or polygon file in a standard Arc-compatible format).

Double click on the westlawr.tif file icon.  A button box labeled westlawr.tif should appear in the legend box of View1.  Click on the button.  A scanned version of the SW corner of the West Lawrence quad sheet should appear in the View1 window.

Zoom in and roam, using the magnifying glass buttons and the hand button.

Notice that the UTM coordinates of the cursor are constantly being updated on the far right of the button bar.  Go to the southwest corner of the map.  With the cursor, find the UTM coordinate of the SW corner of the map.

Get around the map using the right mouse button.  From a point, click the right mouse/trackpad button.  Look at the accompanying dialog for zoom and pan.

Part B. Changing map colors in the legend.

Access to how any theme is displayed is done in the legend of the view.  This is true for features (next exercise) as well as images.  We will change the image here to see how this works.

Double click on the image name in the legend.  A dialog for “Image Legend Editor” will appear.  The image can be adjusted in a number of ways.  For this map, choose the “Colormap” option.  This will display all the colors used on the scan.  Experiment with changing the color by double clicking on the color in the legend.

This is useful for taking topographic maps and making them transparent in ArcView.  For example, whites and greens can be turned to “no color” by clicking the upper left box in the color table (box with X from corner to corner).

Look at geologic maps

Start to under how maps are put together to start simple queries.

Exercise 2. Part A.  Displaying geological field contacts digitized off California Division of Mines and Geology 1:250.000 scale maps.

Click on StartUp, Programs, ESRI, and ArcView 3.0 to start up the “desktop GIS” program.  Expand the main window.

Double click on the Views Icon to open the View1 window.  Expand the View1 window.

Click on the Add Theme button.  A theme can be any type of data set that ArcView is programmed to display, such as sets of points, lines, polygons, or images in the proper formats.

In the Add Theme window double click on “c:\” then on “ArcDemo”

You should see two folders with blue boxes on them in the left half of the Add Theme window.  Double click on the folder labeled “fcgc”.  This is an Arc/Info Coverage.  The title fcgc stands for final California geology contacts.

Click the check box to left of fcgc in the View1 window.

The program is now displaying the geological contact coverage.

Click on the zoom button.  Click on the View1 data window to actually zoom in.

Click on the roam button and roam around the window.

Let’s display the different types of contracts.  Double click on the label fcgc.

The Legend Editor should now appear.  This is what you use to change what attributes are displayed, and what is used as their associated symbols, colors, labels, etc.  Under Legend Type, choose Unique Value.

Under Values Field, choose Contact type.  Note that the Color Scheme is something lame like Bountiful Harvest.  Click on Apply to apply this edit to the Legend on the View window.

Note that the display changes.  Different types of contacts are now different colors and the different types are shown on the Legend.

Get back in the Legend Editor window and choose the color scheme High Seas.  Click on Apply and note the change in the color scheme of the display.  Fault contacts should now stand out as darker lines.

Close the Legend Editor window.  Zoom into the SW corner of the display.

Note the three major types of faults in this area, the range-bounding fault at the southeast end of the uplifted Sierran. Batholith, the northwest trending strike-slip faults that help facilitate the northwest-southwest extension in the area, and the east-west trending Garlock fault.

Part B. Displaying multiple themes: Add the rock until polygon Coverage built form the contracts.

Click on the Add Theme button.

In the Add Theme window double click on “c:\” then on “ArcDemo”

Double click on the folder labeled “fcgr”.  This is an Arc/Info Coverage.  The title fcgr stands for final California geology rock units. 

Click on the check box to left of fcgc in the View1 window.  Notice that it overwrites the fcgr display.  The Theme at the top of the Legend is drawn on the top of the Theme below it, etc.  So to overlay one Theme over another on the display the foreground Theme needs to be on top and the background theme below it.  Any number of themes can thus be layered on the display, but at this time, they cannot be transparent.

Pull the contacts above the rock units in the Legend and watch the display change.

Let’s display the different types of rock units.  Double click on the label fcgr.

The Legend Editor should now appear.  Under Legend Type, choose Unique Value.

Under Values Field, we can see the different Attributes associated with each rock unit polygon.  We can use these attributes to look at the rock units by Map Unit, Age, Litho logic type, etc.

Choose the attribute Map unit to display.  This is the actual rock mapping unit abbreviation that was printed on the map.  Choose the Color Scheme Bountiful Harvest.  Click on Apply to apply this

Edit to the Legend on the View window. To change the color of the contacts in the fcgc overlay, double Click on the fcgc box in the Legend.  Double click on the Depositional symbol.  Click on the Paintbrush Button on the Symbol Palette.  Choose the gray box for the Depositional contacts.

Click on Apply.  Note the change in the display.

Experiment with different colors for the different rock units and contact types.  

Try displaying a different Attribute for the rock units using the Values Field in the Legend Editor.

Digitize a map and learn the program and extensions

Exercises to learn more on ArcView and the GeoEditor program: get used to digitizing

Extensions must be loaded

ArcView uses “Extensions” for other programs that work along with ArcView

To load extension, go to the “File” menu and go down to extensions.  Load the extension for GeoClassifier or GeoEditor into the program.  This is the main one used for geologic mapping.

Other extensions are important too.  We will use “EditTools” in subsequent projects.

Exercise 3.  Polygons.  Typically, when digitizing polygonal map units from the computer screen, the map is scanned in small pieces called tiles.  These individual tiles allow the map to be scanned and displayed using inexpensive scanners and computer display monitors.  The tiles are then reassembled in the computer after digitization.  We will work on Carol Dupuis’ thesis map under folder ArcDemo.  It is called rscan7.tif.  The associated .tfw file is also in the folder.  We are going to digitize a generalized set of rock units off this scan tile.  Although Carol had to digitize these down to the actual mapping unit, we are going to lump them into four time units.  Proterozoic, Paleozoic, Mesozoic, and Cenozoic.

Start ArcView

Display (as image data) rscan7.tif in the ArcDemo folder.

Study the image and locate the following features

A large yellow area on the SW edge of the colored area.  There is also another area of the same yellow color in the SE corner of the image.  These are Permian Kaibad Limestone (now marble, all the sedimentary rocks have been deeply buried and metamorphosed).  Although they are Permian age sediments, they formed a landslide block in the Tertiary, and were represented as both Permian and Tertiary on different versions of Carol’s maps.  They are Cenozoic (Tertiary) for our purposes.

The green area adjacent to the landslide blocks is mapped as Undifferentiated Mesozoic metasediments.

To the NE of ‘b’ is an area of brownish yellow with some internal features also mapped within it.  This is also (in place) Permian Kaibab Limestone and is thus Paleozoic.  What is the feature running down the strike of the unit?

The next unit to the NE is the bright yellow colored unit, the Permian Coconino Sandstone.  It is also Paleozoic in age.

The next unit to the NE, the purple one with two thin purple and green subunits is the Undifferentiated Penn/Perm Supai Group.  It is Paleozoic for out purposes.

To the NE of the Hermit Shale outcrop area is a large strike-slip fault which juxtapaposes other mapping units against the Hermit.

To the NE of the strike-slip fault is another area of Supai Group outcrop.

To the NE of that Supai outcrop is an area of purple Mississippian Monte Cristo Limestone (Paleozoic).

NE of that is a large low-angle normal fault and an area of Proterozoic gneiss colored an orangish brown.

Before starting to digitize, it is important to set up the view properties.  This is done by going to the “View” menu and choosing the first option which is properties.  Here you can set the units and projection.  In this case, set distance units and map units to meters.  This will allow us to move around more easily, and measure things on the map. 

We are now going to trace polygons over each mapping unit area, lumping the units by Era.  As we create each polygon, we will also add an Era name as an attribute for the polygon.

Click on View, then New Theme, with a Feature Type of “Polygon”.  Place the theme in ArcDemo and name the theme “rockunit.shp” (it’s a Shapefile, used in ArcView and some other GIS and graphics programs).

Because we will be coming back to this directory a lot, and we want to easily save our work here, we can to the following to make things easier.  Under the file menu there is a command “Set  working directory.”  This changes the default location that add theme, save, etc. go to when doing an action.  Set this to either c:\ArcDemo or c:\data\ArcDemo.  

Add the polygon locations to the map by selecting the drawing button to the right of the text button on the lower button bar. Choose the Polygon tool.

On the main menu, click on Theme then Properties then Editing (on the left side of the Properties window).  Check the box for  “General Snapping” and set the Snap Tolerance to 10 meters.  Snapping allows you to digitize a segment that is a common boundary between two polygons twice and have some hope of the two segments fitting seamlessly together.  Click on OK twice.

Start digitizing the big landslide block in the lower left.  Click on a point on the boundary, then trace out the boundary by clicking on it several times per inch.  Areas of high curvature need more points.  Note that there are “elastic lines” that connect the cursor back to the first point and the last point you have digitized.  When you have almost come back to your first point, you need to double click on your final point and the program will try to connect up your final point to your first point, closing in the polygon.

Now add the attributes to the polygons attribute table.  Click on the Theme Table button (it looks like a table).  Under Edit in the main menu, click on the Add Field.  Tell the program that the type of field is String and the name of the field is Era.

Click on the Edit Button, the middle of the 3 buttons now displayed on the lower button bar.  This allows you to enter names and numbers into the Table.

Enter Cenozoic in the table as the Era.

Repeat the steps above for the other areas.  You should probably digitize the Mesozoic (green) unit as one polygon, the Paleozoic unit as two polygons (one in the central part of the map, one NE of the strike-slip fault), and digitize the Proterozoic unit as one polygon.

When done, choose Table/Stop Editing and Save Edits

Double click on rockunits.shp in the Legend, pick Unique Value and a Values Field of Era.  Display your map and experiment with the colors.  Show it to me when you are done.

Save your project as rockunit.apr under ArcDemo.

Exercise 4.  Lines with classification using GeoEditor.  

Start ArcView and display (as image data) rscan7.tif in the ArcDemo folder.  Geology as described above.  We will start in the southwestern part of the map.

Study the image and locate the following features

We are now going to trace lines over each contact in the area.

Click on View, then New Theme, with a Feature Type of “Line”.  Place the theme in ArcDemo and name the theme “contacts.shp.”

Make sure that contacts.shp is highlighted.  We need to add all the important items into the table for this theme.  To do this, click the blue diamond button on the upper bar.  This is the GeoEditor button that makes the correct table fields.  Add the fields for “contacts” and click OK through the process.

On the main menu, click on Theme then Properties then Editing (on the left side of the Properties window).  Check the box for  “General Snapping” and set the Snap Tolerance to 5 meters.  Snapping allows you to join the ends of lines seamlessly and to join the ends of lines to existing lines.  This step is critical for creating polygons from a line theme. Click on OK twice.

Start digitizing contacts.  On the lower bar, there are 3 icons for digitizing.  These are a point, a line, and a line with breaks.  These are for digitizing points, digitizing lines, and breaking lines.

In GeoEditor, you have several Icons for classifying geologic features.  The are the “C” (contacts), “P” (points), “R” (rock units), “S” (structures), and “D” (done, a tool for other digitizing).  You will use C for contacts.  In addition, there is a menu item for classifying that contains some additional functions, such as editing unit names and formations.

To set a theme for editing, you can use the “Yen” symbol. This will toggle editing on and off, as you can see by the dashed line around the theme box.

Draw a line segment of similar type – dashed or solid.  Try to digitize the whole line.  If you need to pan or zoom in or out, use the right mouse button.

Notice how lines snap together as you digitize.  Also, make sure that lines are updated with the attributes.  Do this by selecting a line or clicking C as you finish digitizing a line.  Then go through the dialog to classify. You can go to the table for the theme and check to make sure that the features are attributed.  As you work, mistaken digitizing can be seen as items with no attributes.  If you need to reselect a line you can use the feature selection tool (a box with an “x” at the corner.

As you digitize, you may want to edit contacts.  You can do this with the vertex edit tool.  This is the open arrow.  Clicking a line shows the vertices.  Move over a vertex to select it.  In addition, clicking on a line segment can add a vertex.

Continue digitizing until you have a closed contact or two.  If you have some dangling lines you can close them temporarily by using another line classified as a map edge.

Note: A possible error may occur when you try to classify.  If you get a message like “Wrong attribute table or no classification fields” there are three probable problems.  1) the fields were not added to the theme using the “blue diamond” icon.  2) the wrong type of theme is selected – trying to add line data to points.  3) the field headings are not aliased.  If the first two are OK, then open the table of the theme, open table properties (under the “Table” menu), and check to make sure that there are aliases for the longer names.  In ArcView, fields can only be 10 characters long, but some of the names are longer.  You  may have to add aliases for “Contacttype”, “Significance”, and “Symbol_angle.”

Putting in rock units as points

Exercise 5.  Adding points for the rock units.  To be most useful and general, each rock polygon (not yet created) must have a point in it containing the attributes of that unit.  We will do this for the unit you just digitized.  These points will be used later for adding attributes to the polygon created.

Click on View, then New Theme, with a Feature Type of “Point”.  Place the theme in ArcDemo and name the theme “rockpts.shp.”

Make sure that rockpts.shp is highlighted.  We need to add all the important items into the table for this theme.  To do this, click the blue diamond button on the upper bar.  This is the GeoEditor button that makes the correct table fields.  Add the fields for “rocks” and click OK through the process.

Make the rockpts.shp theme active and editable.  Then select the point digitizing tool and add a point to the rock unit (anywhere is fine).  Then click on the “R” classifier button and go through the dialog.  

Save changes

Turning lines into polygons and classifying polygons.

Exercise 6.  Cleaning lines.  This checks and establishes the topology of contacts for turning them into polygons.  ArcView does not have a function for this (new versions do), so we use the third-party extension EditTools.  

Go to the file menu and go down to Extensions.  Then turn off the GeoEditor extension and click on the EditTools extension. Click OK.  You will now see an icon with “ET” and the GeoEditor buttons will be gone.

It is a good idea to backup your theme before cleaning it.  Do this by making the theme editable and then using the “Save as” option.  A name like contactbak1.shp is good.  Increment as needed.

EditTools requires map units for the view.  Go to the View menu and click to show “Properties” (top item).  Go to the menu for map units and pull down to select meters.  Click OK.

Start edit tools by clicking the ET button.  Go to Edit Theme and select the contacts.shp theme.  Then start editing.

Select the “Clean” button.  This is the first step in building polygons.  Cleaning is the process by which open units are identified and closed, and other digitizing errors are evaluated.

A bit on topology

Units must close to build polygons.  Snapping helps with this, but cleaning and other steps are necessary.  Lines end in “nodes”.  Nodes are of 3 types

Dangle – a line just ends and the node is dangling.  This is an error if the line is supposed to close. Dangles are really only OK for internal contacts.

Pseudo – two lines join at a point.  This is unusual in that a line should be connected. This is appropriate for maps when digitizing or mapping picks up after a break.  It is also permitted for a contact that changes character, e.g., known to approximate.

Regular – three or more lines meet at a point.  This is the usual case for closed polygons.

After cleaning, all nodes should be Regular or Pseudo, except for internal contacts.

We will “analyze nodes”.  Check the boxes for full extent and for showing regular nodes.  Then click check nodes.  Regular nodes will show in green, pseudo nodes in blue, and dangles in red.  Check to make sure there are no dangles.  If there are, make sure they are internal contacts.  If not, these will have to be fixed.

Sources of errors

Open contact – line was not snapped properly.  Zoom in to the node and check and fix.

No intersection – node snapped to line, but there was no corresponding node on the line.  To solve this run the “Intersection” box with the full option.

Overlapping lines – line is drawn twice in a couple locations.  Select the dangle and mode to the side.  If the line remains, you can delete the node (del key).  You can also use the clean double lines option with a small tolerance chosen (1m).

Other errors – try running the “Close Rings” command.

Check the table to make sure all contacts are classified.

Exercise 7. Lines into polygons and classifying polygons from a point theme.

Save the edits to the contacts theme and stop editing.  The theme is ready to try building contacts

Select build polygons.  The program will now attempt to close all the lines and make polygons.  It will first create a temporary line theme, then the polygons.  Save the line theme into the default directory (/temp).  Then save the polygon theme into the ArcDemo directory as Rockpoly.shp.

When prompted whether you want to use a point theme to add attributes to the polygons press yes.  Then use the rockpts.shp as the proper theme.  

Once done with this, you should have a polygon theme with all the attributes and rock types associated with it.

What could go wrong?

Polygons did not build – reclean and look for errors.  Use intersect, close rings, and clean double lines.  Make sure you use the full options when available.

Polygons did not build correctly or look wrong – check the digitizing.  The polygons may close in the wrong place.  Check by turning the background off.

Put the contacts theme above the rocks theme.  Use the legend editor to customize the appearance of the rocks and contacts.  Try to get the colors of the units similar to that on the map.  For contacts, draw the lines in different colors for faults and depositional contacts.

Turn off the EditTools extension once you have completed the polygons.  You will almost certainly get an error that states “segmentation violation.”  Ignore this and press OK.

Reload GeoEditor

Adding structural data and notes

Exercise 8.  Adding strikes and dips and make a notes theme.  This will show the last of the main modules for making a geologic map.

Click on View, then New Theme, with a Feature Type of “Point”.  Place the theme in ArcDemo and name the theme “s&d.shp.”

Make sure that s&d.shp is highlighted.  We need to add all the important items into the table for this theme.  To do this, click the blue diamond button on the upper bar.  This is the GeoEditor button that makes the correct table fields.  Add the fields for “points” and click OK through the process.

Make the s&d.shp theme active and editable.  Then select the point digitizing tool and add a point where one of the attitudes is displayed.  Then click on the “P” classifier button and go through the dialog.  You will have to guess the strike.  Data are entered using azimuth and the right hand rule (strike azimuth is 90 degrees counterclockwise of the dip direction).

Digitize several more strike and dips and save changes.

Click on View, then New Theme, with a Feature Type of “Point”.  Place the theme in ArcDemo and name the theme “notes.shp.”

Make the theme active and open the notes.shp table.  Go to add field and add a character field called notes.  Make the length 256.

Add an observation note somewhere to the map.  Open the table and type in some kind of description.

Save change.

Continue digitizing as time allows.  Make sure that a few units are digitized and converted to polygons.  Make sure all contacts are properly attributed

Layout map for presentation

Getting the themes in the view ready

Exercise 9.  Working with contacts to display faults and depositional contracts separately and to display the quality of the contact.  Display the strikes and dip data with the correct symbols.  This is done by using a theme definition and using symbology appropriate to the theme.

Go to the view menu and select add theme.  Put on another copy of the contacts theme.  

Now open the theme properties under the theme menu.  Go to the definition icon (hammer with ?).  This will allow us to redefine the theme.  Double click “Contacttype” on the left side and press the equals sign.  Then double click on “fault” on the right-hand column.  Click OK.

Rename the theme faults in the theme name box.  Click OK.  Now you have a contacts theme that contains only the faults.  Use the legend editor to customize the theme so that different types of fault are shown as solid, dashed, and dotted lines.

The theme you altered is for display purposes.  All changes should be made to the original theme (contacts.shp).  It is easy to have display themes on you map as you are mapping.  These will update as you save the source theme (which is always identified in theme properties).  

Color the rock units appropriate colors using the legend editor when all the contacts are ready.

Now make the s&d.shp theme look like a map.  To do this open the theme legend and double click on the point under the symbol column.  Click on the palette symbol in the symbol window (upper right).  Then click “Load” and navigate to C:\esri\av_gis30\arcview\symbols.  Select geology.

Now go down through the symbols and you will find ones for foliation.  Select this into the symbol box. 

You have the right symbol, but now must set its orientation.  This is done using the “Advanced..” button at the bottom left of the legend editor.  Click this and set the rotation field to “Symbol_Angle.” Click OK and Apply and the symbols should show correctly.

Now we need to add dip values to the symbols.  Do this by selecting the theme menu and selecting “Auto-label.”  Select “dip” in the auto-label dialog.  Click OK and the dip values should be on the map.

What can go wrong?

If a point is selected, only that point is labeled.

If the theme is editable, nothing will appear.

You should display the map at about the scale you will print for the symbols to appear the correct size.

Symbols can be moved using the arrow tool.  You can select and drag using this tool.

Label all the rock units in a similar way.  Make the theme active for rockpts.shp.  Use auto-label to label the theme with the unit label or formation name.

At this point, your view should look close to a geologic map.  We will use this in the next exercise.

Making a layout

Exercise 10.  Make a layout to print the map.  

Get the map centered in the view window.  This will be the base for making a printable version.  Close the view.

Select the View icon at the project level and select “New.”  A new window for the view will appear.

A layout is a powerful tool for creating maps.  The main action is done using the right-most button.  There are ways to add data, view, graphics, legends, scales, etc.  

Zoom out so that you see the whole page.  Pick the “world” button (right most).  This adds views (what you just worked on) to the layout.  Go to the layout and click and drag so that the box created fills most of the layout.  At the dialog select the view, you just worked on and select scale to view.  Your map should now be in the view.

Click the world icon and slide down to the scale bar. Add this to your layout.  Do the same with a north arrow.

All features can be resized and moved using the arrow button.

Add a legend to the map. Click the world icon and slide down to the legend tool (several small boxes). Add this to your layout.  This takes what is in the view of your map.  You may edit the view to make this more to your liking.

Lastly, add a title. Click the world icon and slide down to the textbox tool.  Click on the layout and you will get a window to type your map title.  Do this.

Print the map by printing the layout.

Making a project

Exercise 11.  Get the project ready for mapping.

It is easy to set up all the themes and background layers for mapping before going into the field.

Open ArcView.  Push the save button.  Give the project a description name for the area.

Make sure that the GeoEditor extension is on.  Add new themes for contacts, rock units, and points.  Make sure to add the attribute items to the table.

Select the basemap layer as well as any other mapping layers.  These can be topographic maps, orthophotographs, or whatever is available.

Save and be ready to map.

Editing GeoEditor

Exercise 12.  The rocks.

Go to the Classifier menu and select edit formations

Delete names and enter names for the study area.

